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Grouping Data In A Report  1 
Reference query for report: qryEmployeeData  

1 

The Access Report Wizard is a quick and efficient method of building reports.  

Within the series of dialog boxes Access presents is one in which the user can 

choose to group on one or more fields.  Grouping organizes the records on the se-

lected field.  For example, An employee table can be presented in a report by the 

department assigned to each employee.  Another example could be an order table 

organized by the customer who placed those orders or by the month the order was 

received.  

CREATING  GROUPS  I N  THE  REPORTS  W IZARD  

Steps:  

Ý Click the Create Tab  

Ý Click the Report Wizard command (in the Reports group)  

Ý In the first Report Wizard Box , select the table or query from the  

Tables/Queries drop -down list from which you want to base the report  

Ý Move the required fields (from left) to the Selected Fields box (right side) and 

click Next button  

Note : if necessary additional tables or queries can be selected and those 

fields added to the Selected Fields box as well  

Ý Select the preferred Viewing options, if preferred (this box will appear when 

the report is based on multiple tables), and click Next button  

Ý Set the preferred Grouping options, if preferred , and click Next button  

Ý Select Sorting and Summary options, if preferred , and click Next button  

Ý In the Layout box, select preferred options, and click Next button  

Layout  -  indenting positions of data on report  

Orientation  -   Portrait or Landscape  

Adjust Fields checkbox -   to fit all fields across one page only  

Ý In the Styles box, select preferred options, and click Next button  

Ý In the last Report Wizard Box, type a name for the report  

Ý Click Finish button  
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1 
Grouping Data In A Report  

CREATING  GROUPS  I N  THE  REPORTS  W IZARD  

In the first Report Wizard 

Box, select the table or 

query from the  

Tables/Queries drop -down 

list from which you want to 

base the report.  

 

Move the required fields 

(from left) to the Selected 

Fields box (right side) and 

click Next button  

After selecting 

fields to group 

records by  
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1 
Grouping Data In A Report  

CREATING  GROUPS  I N  THE  REPORTS  W IZARD  

In the Layout 

box, select 

preferred 

options, and click 

Next button  

Select Sorting 

and Summary 

options, if 

preferred , and 

click Next button  
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1 
Grouping Data In A Report  

CREATING  GROUPS  I N  THE  REPORTS  W IZARD  

In the Styles 

box, select 

preferred 

options, and click 

Next button  

In the last Report 

Wizard Box, type 

a name for the 

report  
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1 
Grouping Data In A Report  

CREATING  GROUPS  I N  THE  REPORTS  W IZARD  

Completed Employee Report Grouped By Department (in Report View)  
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1 
Grouping Data In A Report  

CREATING  GROUPS  I N  THE  REPORTS  W IZARD  

Grouping Dates In The 

Report Wizard  

Reference query for report: qryCustomerOrdersWithItems   
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1 
Grouping Data In A Report  

CREATING  GROUPS  I N  THE  GROUPING  AND  SORTING  PANE  

In addition to creating groups in the Report Wizard a user can create, customize, and 

remove groups in the Group and Sort Pane in the Report.  In this pane a user can 

also activate that groups Footer Section in which to place calculated expressions.  

The Group and Sort Pane can be opened from the Design tab of the Report Design 

Tools.  

Steps:  

Ý Change the view to the Design View  

Ý Click the Group and Sort command on the Design tab  

Ý Click Add A Group button  

Ý Select the field to group  

Ý To change sorting from default of ascending, clické  (i.e. with A on top )  

Ý To change grouping interval, clické (i.e. by entire value )  

Ý To add totaling and page breaking  

options, click, More  

Ý Preview changes in Print Preview,  

Report View, or Layout View  

Reference report: rptCustomers  
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1 
Grouping Data In A Report  

CREATING  GROUPS  I N  THE  GROUPING  AND  SORTING  PANE  

Selecting Field to Group In The Group And Sort Pane  

Activating The Group And Sort Pane  

Click Add A Group Button  
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Adding Field Totals In The Group And Sort Pane  

1 
Grouping Data In A Report  

CREATING  GROUPS  I N  THE  GROUPING  AND  SORTING  PANE  

Completed Field Grouping In The Group And Sort Pane  

Reference report: rptCustomers  
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1 
Grouping Data In A Report  

CREATING  GROUPS  I N  THE  GROUPING  AND  SORTING  PANE  

Completed Report From Group And Sort Pane  
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2 Design A Summary Only Report  

DESIGN  A S UMMARY  ONLY  REPORT  

Using the Access Report Wizard, a user can create a Summary Only report.  This 

is a report that only displays the aggregate totals of the data without each of the 

records being visible.  Functions included are Sum, Average, Min, Max, and 

Count .  In addition, the user can activate an option to show each aggregate totalôs 

percentage to the entire report total.  

In order for summary options to be available during the Report Wizard, the user 

must select a field to group and set the Summary Only  option on in the  

Summary Options dialog box.  

Steps:  

Ý Click the Create Tab  

Ý Click the Report Wizard command (in the Reports group)  

Ý In the first Report Wizard Box , select the table or query from the  

Tables/Queries drop -down list from which you want to base the report  

Ý Move the required fields (from left) to the Selected Fields box (right side) and 

click Next button  

Ý Set the preferred fields to Group , and click Next button  

Ý Select Sorting and Summary options, if preferred  

Ý Click the Summary Options  button  

Ý In the Summary Options box, check the summary options for the preferred 

fields (i.e. Sum, Average, Min, Max)  

Ý Click the Summary Only checkbox, click OK , and then click Next button  

Ý In the Layout box, select preferred options, and click Next button  

Layout  -  indenting positions of data on report  

Orientation  -   Portrait or Landscape  

Adjust Fields checkbox -   to fit all fields across one page only  

Ý In the Styles box, select preferred options, and click Next button  

Ý In the last Report Wizard Box, type a name for the report  

Ý Click Finish button  

Reference query for report: qryCustomerOrdersWithItems  
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2 
Design A Summary Only Report  

In the first Report Wizard 

Box, select the table or 

query from the  

Tables/Queries drop -down 

list from which you want to 

base the report.  

 

Move the required fields 

(from left) to the Selected 

Fields box (right side) and 

click Next button  

After selecting 

fields to group 

records by  

DESIGN  A S UMMARY  ONLY  REPORT  
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2 
Design A Summary Only Report  

DESIGN  A S UMMARY  ONLY  REPORT  

Select Sorting 

and Summary 

options, if 

preferred.  

 

Click the Summary 

Options button  

Make sure to turn 

on Summary Only 

option  
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2 
Design A Summary Only Report  

Completed Monthly Orders Summary Report in Print Preview)  

DESIGN  A S UMMARY  ONLY  REPORT  
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3 Adding a Calculated Control  

ADDING  A  CALCULATED  CONTROL  

Tables can not contain calculated fields.  Calculations can be performed in a query 

and then added to the report automatically during the report creation process, for 

example, with the Report Wizard.  However, queries can only calculate at the record 

level.  In order to calculate groups or entire reports, calculated fields need to be 

added in the Report Design.  

The tool used to add calculated controls to a report is the Textbox tool located on the 

Design Tab of the Report Design view.  

Calculations in a report can appear at the record level ( Details section ), the group 

level ( Group Header or Footer ), and the report level ( Report Header or Footer ).  

Reference report: rptEmpByDeptCalculations  

Steps:  

Ý After creating the report, click the Design View button  

Ý Click the Design tab , if necessary  

Ý In the Controls Group , select the Textbox tool  

Ý Place the mouse over the area where the calculated control will be placed (i.e. 

Dept Footer section) and click once  

Note :  The Group Footer may have to be activated first using the 

Group And Sort Pane (Design Tab)  

Ý In the Unbound  part of the control, Right - Click and select Properties  

Ý In the Properties window , click into the Name property cell and type name  

(i.e. txtGrpTotal)  

Ý Press Enter  to move to the Control Source property  

Ý Click the Build  button  

Ý In the Expression Builder , create the expression (see page 19), click OK  

Ý Press Enter in Control Source property cell ( MUST DO THIS!!! )  

Ý In the Format property cell , select the preferred format, and press Enter  

Ý Click on the Label part of the control  

Ý In the Caption property , type a label for this field (i.e. Group Total)  

Ý Save  and Preview the report in Print Preview  
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3 
Adding a Calculated Control  

ADDING  A  CALCULATED  CONTROL  

Controls Group on the Design Tab of Report Design Tools  

Unbound Control Placed on Report  

Name Property For Unbound Control In Property Sheet  

Control Source Property For Unbound Control In Property Sheet With Build Button  

Completed Calculated Control In Property Sheet  Label Control Properties  
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ADDING  A  CALCULATED  CONTROL  

Report Prior To Adding Calculated Controls (seen in Print Preview)  

3 
Adding a Calculated Control  
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ADDING  A  CALCULATED  CONTROL  

Calculated Controls Added To Report (seen in Print Preview)  

3 
Adding a Calculated Control  
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3 
Adding a Calculated Control  

W ORKING  I N  THE  EXPRESSION  BUILDER  

The Expression Builder dialog box can help a user create and edit calculated ex-

pressions much like the Insert Function box in Microsoft Excel.  Using the expres-

sion builder eliminates having to put all the proper syntax in a calculation manually.    

The expression builder can be used in a Access query, form, or report.  

The Expression Builder in a report is accessed in the Design View through the 

Properties Sheetôs Control Source property cell, using the Build Button.  

Steps:  

Ý View report in Design view  

Ý Activate and place the Textbox control in the preferred section of the report  

Ý Right - Click on the Textbox control and select Properties command  

Ý In the Properties sheet , click into the Control Source property cell  

Ý Click the Build button  

Ý In the Expression Builder , create the calculated expressioné 

§ If using a function (i.e. Sum, Average, Count)  

§ In the far left column , open the Functions folder  

§ In the middle column , click <All>  

§ In the far right column , find and double - click the preferred function  

Ý Click on the <expr> placeholder to select it  

Ý Replace with fields or other required arguments  

Ý To select fieldsé 

§ In the far left column , open the Current Object folder (i.e. report name)  

§ In the middle column , click <field list>  

§ In the far right column , find and double - click the preferred fields, click-

ing or typing any required operators (i.e. +) in between each selection  

Ý Click OK when complete  

Ý Press Enter in Control Source property cell ( MUST DO THIS!!! )  
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3 
Adding a Calculated Control  

W ORKING  I N  THE  EXPRESSION  BUILDER  

Expression Builder -  ñBuilt-In Functionsò Folder Open 

Expression Builder -  Example of Calculated Expression  

Double - Click Field To 

Place in Upper Region 

of Expression Builder  

Select the <<expr>> 

placeholder before 

selecting field (see 

below)  
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3 
Adding a Calculated Control  

CREATING  A R UNNING  SUM  EXPRESSION  

A Running Sum is simply a calculation that displays a cumulative total to that point 

in the report (i.e. at the end of a group section).  This can be very useful when de-

signing a report with multiple levels of grouping.   

The running sum is a property assigned to a calculated expression in the Property 

Sheet for that control.  The running sum can be set to display the cumulative total 

for each record, the whole group, or overall to that point in the report.  

Steps:  

Ý Create calculated control in report using Textbox tool  

Ý Right - Click on Textbox control and select Properties command  

Ý In the Properties Sheet , click the Data tab  

Ý Click into the Running Sum property cell  

Ý Set the appropriate optioné 

§ No (default)  No running sum is calculated  

§ Over Group  a running sum is calculated for each group independently  

§ Over All   a running sum is calculated for all the groups through that 

   point in the report  

Ý Press <Enter> to move to next property cell  

Ý Save report  

Ý Preview data in Print Preview, Report View, or Layout View  

Reference report: rptRunningSum  
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3 
Adding a Calculated Control  

CREATING  A R UNNING  SUM  EXPRESSION  

Running Sum Property On Data Tab  
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4 Modifying Report Properties  

Reference report: rptReportProperties  

SETTING  REPORT  LEVEL  PROPERTIES  

Properties in a report are customizable at three levelsé Report , Section   

(i.e. Report Header/Footer, Page Header/Footer, Group, and Detail), and Control 

(i.e. Employee Name).   

Report level properties allow the user to customize the source of the report as well 

as some display oriented properties of that report.  

Steps To Customize Report Level Properties:  

Ý View the report in Design View  

Ý To select the reportôs property level, Right - Click into the top left square of 

the Report Section  

Ý Select Properties  

Ý In the Properties Sheet , click the appropriate tab  

Ý Customize the appropriate properties  

Ý Save  the report  

Ý Preview  the report in Print Preview, Report View, or Layout View  

Some Report Level 

Properties  

Purpose  Property Sheet Tab  

Record Source  User can view or change the source table or 

query of that report  

Data  

Caption  Format  User can customize report title in Title Bar  

Page Header  

Page Footer  

Format  User can prevent page headers and/or 

footers from displaying on first or last page 

of the report (i.e. Cover Page)  

Picture  Format  User can specify image to use as background 

of report.  Image should be customized into 

a watermark (washout) previously  

Picture Pages  Format  User can specify whether image placed in 

picture  property displays on every page  

4 
Reference report: rptReportProperties  



C
 H

 A
 P

 T
 E

 R 

24  Microsoft  Access 2007 Database Training For The Haas School of Business, UC Berkeley -  Dash Designs Consulting  

 

4 
Modifying Report Properties  

SETTING  REPORT  LEVEL  PROPERTIES  

Right -Click For Report Level Properties  

Format Tab of Properties Sheet  

Contains é 

Caption  

Picture  

Picture Size Mode  

Page Header  

Page Footer  

4 
Modifying Report Properties  
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4 
Modifying Report Properties  

Reference report: rptReportProperties  

SETTING  REPORT  LEVEL  PROPERTIES  

Report Without Properties Set  
Caption  



C
 H

 A
 P

 T
 E

 R 

26  Microsoft  Access 2007 Database Training For The Haas School of Business, UC Berkeley -  Dash Designs Consulting  

 

4 
Modifying Report Properties  

SETTING  REPORT  LEVEL  PROPERTIES  

Report With Caption and Picture Properties Set  
New Caption  

Picture Property using Whale Washout.jpg image  
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4 
Modifying Report Properties  

Reference report: rptControlProperties  

SETTING  CONTROL  LEVEL  PROPERTIES  

Controls include fields created in the source tables, calculated controls, or images 

and text added to that report.  Properties at the Control level allow the user to cus-

tomize properties such as the source of the control, the formatting of that control, 

running sum properties, and whether an entry in that control can wrap within the 

boundary of that control.    

Steps:  

Ý View the report in Design View  

Ý Right - Click on the preferred control, and select Properties  

Ý In the Properties Sheet , click the appropriate tab  

Ý Customize the appropriate properties  

Ý Save  the report  

Ý Preview  the report in Print Preview, Report View, or Layout View  

Some Control Level 

Properties  

Purpose  Property Sheet Tab  

Name  User can set the internal name for a 

calculated or Unbound control  

Other  

Control Source  Data  User can view or change that controlôs 

source  

Format  Format  User can customize how the entry in that 

control displays (i.e. Number or Date 

formatting)  

Running Sum  Data  User can specify whether that calculated 

control displays a group total or a cumulative 

total through that group  

Can Grow  Format  User can specify whether that control can 

wrap within the boundary of the control  
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4 
Modifying Report Properties  

SETTING  CONTROL  LEVEL  PROPERTIES  

Reports Before & After Setting Can Grow Property  


